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Overview 

This guide details how to set up Infor VISUAL Global Financials to create EFTs (Electronic Funds 
Transfers) to submit for payments. You can create EFTs in two ways: with the Format Editor or with 
the VISUAL Exchange service. Both methods are viable; however, going forward only the Format 
Editor method will be updated and enhanced. 

This table shows the differences between the Format Editor and Exchange Service methods: 

 Format Editor method Exchange Service method 

Method available 
since: 

November 2016 Inception of product 

Formats: Templates provided for use 
with these payment systems: 

• BACS 

• CLIEOPS-03 

• EBT 

• NACHA-CCD 

• SEPA_PAYMENT 

You can create customized 
versions of these file types 

Supports these payment 
systems: 

• BACS 

• CLIEOPS-03 

• EBT 

• SEPA_PAYMENT 

These formats are stored in 
Exchange. Customization 
options are limited. 

Driven by definitions 
for: 

Document Type  

Format ID 

Payment Method 

Document Type 

Instance and Subscription 

Payment Method 

Transform Constant 

This document discusses only those items required for successful use of either the Format Editor 
method or the Exchange Service method. For fields and options not discussed in this document see 
the VISUAL for .NET online help for additional information about Payment Methods, Document 
Types, Payment Runs, Payment Run Generation, Transform Constants, Instances, and 
Subscriptions. 
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Using the Format Editor to create EFTs for 
payments 

This section details how to use Infor VISUAL Global Financials’ Format Editor to create an electronic 
bank file. The process involves these setup and payment generation steps:  

• Setting up an electronic funds transfer. 

1 Identifying, copying, and modifying the file format. 

2 Defining the payment method. 

3 Defining the document type. 

• Setting up and generating a payment run for the electronic file. 

1 Setting up the payment run. 

2 Generating the payment to send to the bank. 

Identifying the file format to use 
Templates are provided for these file formats: 

• BACS 
• CLIEOPS-03 
• EBT 
• NACHA-CCD 
• SEPA_PAYMENT 

You can use the default templates as-is, or create customized copies of the templates to better suit 
your business needs.  

If the information included in the template meets your company’s needs, proceed to the “Defining a 
payment method for electronic transfer” procedure. You can review the information included in each 
template in File Format Maintenance. You can review a template by clicking the Format ID browse 
button and selecting the template. Use the Record Types and Format tabs to review the information 
included in the template.  
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If a template does not meet your company’s needs, you can create a customized copy of the 
template. You cannot edit the original template file. To customize a template, you must create a copy 
of it. 

Customizing file format templates 
To customize a template: 

1 From the Financials Maintenance window in Global Financials, click the Administrative tab. 

2 Click File Formats. 



Using the Format Editor to create EFTs for payments 

Infor VISUAL for .NET Financials Global Edition Electronic File Transfers  | 7 

3 Click the Format ID browse button and select the template to modify. 

4 Click the Duplicate current document toolbar button. 

5 In the Format ID field, specify the ID for your customized file format. 

6 Click Save.  

7 In the header, modify this information as necessary: 

File Type – Select EFT. 

Name - Specify a name for the file format. The default template file names cannot be modified. 

Format Type – Select the file format to be generated. You can select either Text or XML. 

Data Source – Select the service used to obtain the data for the format. The data source that 
you select determines the tables and columns that are available in the Data Expression field on 
the Format tab.  

8 In the Record Type tab, modify the record types included in the file format as necessary.  

9 To modify individual record lines, click the Format tab. Use these records lines to define the 
information sent to the bank. 

The columns on the Format tab are used differently depending on the Format ID and Format 
Type. Refer to the templates for a better understanding of how the fields are defined. 

Record Type – Specifies the type of record and corresponds to records displayed on the Record 
Types tab. 

Field Name – Specifies the name that describes the data on the line. 

Start Pos /Seq No – Specifies the start position of the line data, or the sequence number. 

Width – Specifies the width of the field. 

Alignment – Specifies the alignment of the field as Left, Right, or None. 
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Pad Char – If the field is to be padded, the value is specified here. 

Reqd – Select this check box if the field must be included in the electronic file. 

Text / Format – You can use this field for these purposes: 

• If the field contains a hard-coded value, specify the value in this field. For example, the 
BACS template contains a field called Constant 99. Because 99 is the only valid value for 
this field, 99 is specified in the Text/Format field. 

• If the field returns data based on a Data Expression, use this field to specify the format of the 
data. For example, if you specified CurrentDate() in the Data Expression field, you would use 
this field to specify the format of the date. For example, you could specify {0:yyyy-MM-dd}. 

Start Delim – Specifies the characters that are placed before the Data Expression results. 

Data Expression – To populate the field with information from the database, or to use a function 
to populate the field, click the browse button. You can use the Column tab to select the column 
that supplies the data for the field or use the Function tab to select a function. If necessary, you 
can create complex expressions. 

End Delim – Specifies the characters placed after the data expression results. The value “+” 
concatenates the next record onto the same line of the output file. 

Indent Level – Specifies the correct line indentation. 

RecNo – Specifies the record’s sequence number. 

10 Click Save. 

Exporting and importing the file format template 
You can export or import the file format template to and from xml, typically for support purposes. 

To export the file format template: 

1. From the File Format Maintenance window with a File Type and Format ID selected, click 
Export File Format in the Tasks menu. 

2. Select the file directory and name for the exported file. 
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3. Click Save. 

To import the file format template: 

1. From the File Format Maintenance window, click Import File Format in the Tasks menu. 

2. Select the xml file and click Open. 

3. Specify the File Type and the Format ID. 

4. Click OK. 

Defining a Payment Method for Electronic Transfers 
To generate an electronic transfer set up at least one electronic payment method: 

1 From the Financials Maintenance window in Global Financials, click the Administrative tab. 

2 From the Administrative Tab, click Payment Methods. 

3 To create a new payment method, click the Insert Row button and specify this information: 
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Payment Method ID – Specify the identification code to use for the payment method. 

Description – Specify the description of the payment method. 

Media – From the drop-down list, and select Electronic. 

File Format ID – Specify the File Format ID. If you leave this field blank, the file is generated 
using the VISUAL Exchange process. 

EFT Outbound File – Specify a file name using one of these methods: 

• To use the same EFT file name for all electronic files generated for this payment method, 

specify the file name. 

• To create file name using variables, click the browse button. These variables for 
example: =CurrentDate.Month() + "-" + CurrentDate.Day() + "-" + CurrentDate.Year() + 
"SEPA" + GET_CHECK_DETAILS.PAY_RUN_ID create mm-dd-yyyySEPAxxxxx, where 
“xxxxx” is a Pay Run ID. 
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EFT Outbound Folder – Click the browse button to locate the directory where you want the file 
created. 

EFT Archive Folder – Click the browse button to locate the archive directory where you want to 
store historical file copies. The archive folder cannot be the same as the outbound folder. 

4 Click Save to add the payment method to your database. 

Defining a Document Type for Electronic Transfers 
After you set up an electronic payment method, define a document type to use for electronic 
transfers. 

To set up a document type for electronic file transfers: 

1 From the Administrative tab in the Financials Maintenance window, click Document Types. 

2 Specify information in these fields: 

Document Type ID - Specify an ID for the document you plan to use for electronic transfers. 

Description - Specify a description of the Document Type ID. 

Journal Type – Select Payment Runs from the Journal Type drop-down button. 

Bank Account ID - Select the Bank Account ID from the drop-down button or browse button 
that you want to associate with electronic transfers. Verify in Bank Account Maintenance that the 
Bank Account ID you select has a 10-digit account number without spaces or dashes. 

Payment Method ID - Click the drop-down button and select the electronic payment type you 
created in Defining a Payment Method for Electronic Transfers. 
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3 Click Save to save the document type to your database. 

Defining the Payment Run 
After you set up your electronic file format, you define your payment run. 

1 From the Financials Maintenance window in Global Financials, select the Cash Management 
tab. 

2 Click Payment Run. 

3 Select the document type that you created for electronic file transfers from the Document Type 
drop-down button or browse button. 

4 Specify information in the remainder of the Payment Run Setup window as necessary. 

All suppliers identified in the Payment Run must have a default Bank record defined on the 
Supplier record (Entity Tab, Banks Sub Tab) with the proper identification and routing numbers 
including a 10-digit value placed in the Account Number field. 
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5 Click Save. 

Generating Payments 
After you set up the payment run, generate the electronic payments. 

1 From the Cash Management tab in the Financials Maintenance window, click Payment Run 
Generation. 

2 Select the Payment Run ID that you created from the Pay Run ID drop-down button or browse 
button. 

3 Verify that the date is correct in the Posting/Check Date field. 

4 Click the Start tab. 

5 Verify that the Starting Payment ID is correct. 
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6 Click Go. 

7 Click the EFT Results tab to display the payment generation results. 

An EFT file is created with the name that you specified in Payment Method Maintenance and 
stored in the outbound directory that you specified. 

Click Regenerate File to create the file again if necessary. 

Click Create Advices Payment Method to create and e-mail or print remittance advices as 
needed. 
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Using the Exchange Service to create EFTs for 
payments 

This section details how to set up Infor VISUAL Exchange to create an electronic bank file from the 
Payment Run process within Infor VISUAL Financials Global Edition (Global Financials). The 
process involves these setup and payment generation steps: 

• Setting up an electronic funds transfer. 

1. Defining the payment method. 

2. Defining the document type. 

3. Setting up a transform constant. 

4. Setting up an instance file. 

5. Defining the subscription. 

• Setting up and generating a payment run for the electronic file. 

1. Setting up the payment run.  

2. Generating the payment to send to the bank. The Exchange Service must be running before 
you generate payments. 

Defining a Payment Method for Electronic Transfers 
You must set up at least one electronic payment method to generate an electronic transfer. 

To generate an electronic payment method: 

1 From the Financials Maintenance window in Global Financials, click the Administrative tab. 
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2 Click Payment Methods. 

3 To create a new payment method, click the Insert Row button and specify this information: 

Payment Method ID - The identification code to use for the payment method. 

Description - The description of the payment method.  

Media - Select Electronic from the Media drop-down button. 

File Format ID - Leave this field blank when using the Exchange Service procedure for 
producing EFT bank files. 

4 Click Save to add the payment method to your database. 
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Defining a Document Type for Electronic Transfers 
After you set up an electronic payment method, you must define a document type for electronic 
transfers. 

To set up a document type for electronic file transfers: 

1 From the Administrative tab of the Financials Maintenance window, click Document Types. 

2 Specify information in these fields: 

Document Type ID - Specify the ID for the document you plan to use for electronic transfers. 

Description - Specify the description of the Document Type ID. 

Journal Type - Select Payment Runs from the Journal Type drop-down button. 

Bank Account ID – Select the Bank Account ID from the drop-down button or browse button 
that you want to associate with electronic transfers. Verify in Bank Account Maintenance that the 
Bank Account ID you select has a 10-digit account number without spaces or dashes. 

Payment Method ID - Select the electronic payment type you created from the Payment 
Method ID drop-down button or browse button. 

3 Click Save to save the document type to your database. 

Setting Up a Transform Constant 
You must set up a transform constant for your electronic transfers, now that you have set up an 
electronic payment method and defined a document type for electronic transfers. 
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To set up a transform constant for your electronic transfers: 

1 Access Exchange from the Home Page by selecting Tools, Exchange Maintenance. 

2 From the Exchange Maintenance window, click the Setup Tab and then click Transform 
Constants. 

3 Select the row for the electronic transfer type you want to set up. The system supports four types 
of electronic transfer within the Exchange Service procedure: BACS, CLIEOP, EBP, and SEPA. 

4  From the drop-down button in the Value column, select your electronic payment method. 

5 Click Save. 

Setting Up an Instance File 
Use the Instance Maintenance window to define the directories where the system should save the 
electronic transfer file and retain an electronic transfer file archive. 

1 From the Setup tab in Exchange Maintenance, click Instances. 
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2 Click the Instance ID drop-down button or browse button and select VFINFILE. 

3 Click the File tab, and specify this information: 

Outbound Directory - Click the browse button to select where to store the EFT files. 

Outbound Archive Directory - Click the browse button to select the outbound archive directory. 
Your archive directory location must be different from the Outbound Directory file location. 

Delete archive files after - Specify the number of days to retain archive files in the Outbound 
Archive Directory. 

4 Click Save. 

Defining the Subscription 
After you set up an instance file, define the subscription between your Global Financials database 
and the instance file. 

1 From the Setup tab in Exchange Maintenance, click Subscriptions. 

2 From the General tab’s Subscription ID drop-down button or browse button, select the 
subscription for the electronic file transfer type. 
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3 In the File tab’s Outbound File Name field, specify an outbound file name using one of these 
methods: 

• To use the same EFT file name for all electronic files generated for this payment method, 
specify the file name.  

• To create file name using variables, click the browse button. These variables for example: 
=CurrentDate.Month() + "-" + CurrentDate.Day() + "-" + CurrentDate.Year() + "SEPA" + 
GET_CHECK_DETAILS.PAY_RUN_ID create mm-dd-yyyySEPAxxxxx, where “xxxxx” is a 
Pay Run ID. 

Only enter Outbound Directory and Outbound Archive Directory information, if you are using 
directories that are different than the ones set up in Instance Maintenance. 

4 Click Save. 

Defining the Payment Run 
After you set up your electronic file format, you define your payment run. 
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To define the payment run: 

1 From the Financials Maintenance window, select the Cash Management tab. 

2 Click Payment Run. 

3 Select the document type that you created from the Document Type drop-down button or 
browse button. 

4 Specify information in the remainder of the Payment Run Setup window as necessary. 

All suppliers identified in the Payment Run must have a default Bank record defined on the 
Supplier record (Entity Tab, Banks Sub Tab) with a 10-digit value placed in the Account Number 
field. Input strings errors in the VISUAL Exchange Activity Log can indicate a supplier without a 
defined Bank or Account Number. 

5 Click Save. 

Generating Payments 
After you set up the payment run, generate the electronic payments. 
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To generate the electronic payments: 

1 Confirm that the VISUAL Exchange Service is running. Manual Exchange Requests for EFT 
Files are not supported. 

2 From the Cash Management tab of the Financials Maintenance window, click Payment Run 
Generation. 

3 Select the Payment Run ID that you created from the Pay Run ID drop-down button or browse 
button. 

4 Verify that the date is correct in the Posting/Check Date field. 

5 Click the Start tab. 

6 Verify that the Starting Payment ID is correct. 

7 Click Go.  

8 Click the EFT Results tab to display the payment generation results. 



Using the Exchange Service to create EFTs for payments 

Infor VISUAL for .NET Financials Global Edition Electronic File Transfers  | 23 

 

The system creates the EFT file with the name you specified in Subscription Maintenance and 
saves the file in the directory you specified in Instance Maintenance. 

Click Regenerate File to create the file again if necessary.  

Click Create Advices Payment Method to e-mail or print remittance advices as needed. 
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